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Introduction

INTRODUCTION

Welcome to School Accounting for Windows.

Basic Accounting Program Module

This program module helps administrators maintain a more effective
control of their funds in a school or district. It is used for
Activity Accounting and basic Fund Accounting.

The program allows for a 6 digit account code and 4 digit sub-account
code. You'll always know what your current balances are for any
Account or GL Account code.

You'll print a wide variety of reports to the screen or printer.

You'll use the mouse or keyboard to operate the program. Pull down
Menus and Windows make the program extremely easy and quick to use.
You don't have to be a CPA to operate the program. Double entry
accounting is done automatically for you.

Help is just a keystroke away! Press [F1] or click on Help with the
mouse at any time... from anywhere in the program.

Security is built into the program to protect your data from unwanted
users. It's simple to use, yet very effective.

Additional Program Modules
There are two additional program modules you may purchase and use with
the School Accounting Program for Windows. These programs can work
together and save you a lot of time... or you can install and use them
separately. The choice is yours.

1) Extended Codes (Expense and Revenue)

This program module is used to increase the expense and revenue coding
capabilities associated with each transaction for increased tracking
and analysis. It allows the school to define up to ten different
categories of expense codes (up to 100 additional digits) and ten
categories of revenue codes (up to 100 additional digits) for a total
of 200 additional digits of codes. You don't have to use all 200
digits. Only use the digits you'll need.
The program automatically configures itself once the school enters
their additional account codes. The automatic default option
increases the speed and ease of use when the school has a code that
consistently needs to be entered. For example: if you have an FY Code
that's the same for each transaction, the default option will
automatically enter this for you.
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This program also includes an Extended Report option. These reports
give you a detailed journal printout of your expenses, receipts, and
payables by extended codes. The report sorts all your data by extended
code. A subtotal is given for all ten groups of extended codes every
time codes change.

2) Purchase Orders

This program module is used to enter, print, and keep track of all
purchase orders issued by the school. You can receipt an entire
purchase order or line item by clicking one button with your mouse. In
addition, you can enter partial receipts for a purchase order line
item and make changes as needed. Once all items are received, you can
automatically post the purchase order to accounts payable, if you’re
using the basic accounting module.

The School Accounting program can be as simple or complex as your
needs require. It is modular in design. Use one program or all
programs. You can add these additional programs as the need arises in
the school.

The complete program prints over 35 standard reports to help you keep
track of all your school accounting needs.

I. Basic Accounting Program.

This manual explains the specific details about the Basic Accounting
program. Think of it like a recipe. It contains all the details or
what you want to do.

The Basic Accounting manual contains:

Chapter Information                   
  1 Quick Start, Installing the

program and Overview.

  2 File Menu, Information to Add to
the program.

  3 Output Menu, Basic Accounting
Reports you can print to the
screen or printer.

  4 Utilities Menu, Special programs
to simplify your accounting work.

  5 Registering your Software or
          Updating your support contract.



Introduction

  6 Questions & Answers, Answers the
most commonly asked questions.

II. EPES Software Reference Manual

This manual explains how to:
• Select Menu Options.
• Use the keyboard or mouse.
• Make Backups of your data.
• Add, Edit, and Delete information... and much more.

The EPES Reference manual contains:

Chapter Information                   
  1 File Menu, How to select program

options, Close Files, select
Printers, and Exit the program.

  2 Edit Menu, How to Edit entries.

  3 Commands Menu, How to use the
Tool Bar Menu to add, edit, and
view information; how to use
keyboard or mouse to move around
in the program.

  4 Output Menu, How to print reports
to the screen or printer.

  5 Window Menu, How to move a window
on the screen, change it's size,
and select other windows on the
screen.

  6 Utilities Menu, Programs which
perform special functions like
backing up your data, recreating
damaged indexes, etc.

  7 Help Menu, How to get help using
the program.

  8 Administrator Menu, How to add
users to the program and assign
their rights to add, edit, delete
or view information.
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Think of the reference manual as an oven. You can use the oven every
time you bake. Once you're familiar with how the oven works, you know
how to use it for all your recipes.

We have one major objective in mind:

Once you know how to use one EPES program for Windows, you'll know how
to use all of them.

How is the Manual Written?

The following information will help you understand how the manual is
written.

Symbol    Meaning                       
[ ] Information enclosed in brackets means to press a key. For

example, [A] means press the letter A.

<   > Information enclosed in braces means to select a command on
the screen. For example, < Add > means select the Add
command.

'   ' Information enclosed in single quotes means to select a Menu
option. For example, 'Accounts' means select the Accounts
option from the Menu.

"   " Information enclosed in double quotes refers to a message on
the screen or a section in your manual.

_______: Information followed by a colon refers to information you
are to type into the program. For example, Password: means
type in the password.
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CHAPTER 1

QUICK START

This chapter is an overview of the Basic Accounting program. You'll
learn how to install the program and get started.

Installing the EPES Accounting Program

Place the School Accounting CD in your CD Rom drive, select Run. Enter
the following:

E:Setup (or whatever drive is assigned to your CD Rom Drive)

To install the program, follow the instructions displayed on the
screen. When the program has been successfully installed, the final
message you'll see will be "Installation is complete". Put the
original program CD in a safe storage place.

Installing Additional EPES Accounting Programs

The EPES Accounting program actually includes the Purchase Order and
the Extended Code programs.  You can preview either of these programs
in “Demo” mode at any time by going to the “Switch Program” option and
selecting the program you want to preview.  If you decide to purchase
either of these modules you will only receive a “Registration”
diskette which will change these programs from a “Demo” to a fully
functional program.  Chapter 5 of this manual provides detailed
instructions.
Each module purchased will be a ‘Demo’ until registered.

First Time You Run the Program
After first installing the program, the program is running in ‘DEMO’
mode.  In Demo mode you can test every option in the program.

Registering the Program:
To gain unrestricted access to the program you must register it.  To
register a program, do the following:
1) Purchased from our Sales Office:
If you ordered the program from our office the registration
information is on the CD Rom.  Put the CD Rom in your CD Rom Drive.

Under the Utilities Section select
‘Registration/Support’, select
‘Register Program’.
If you are registering from an older version on Diskette, the defaults
are correctly set.  To register from the CD Rom you will need to check
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the box marked “Other Drive Path” and enter your CD Rom drive in the
box.
Once the appropriate options are entered select ‘OK’.
2) Registering a Demo program downloaded from our Web Site.
If you downloaded the demo program and want to purchase it contact our
sales office :1-800-424-7512 or email us at:
sales@epessoftware.com.  When payment or Purchase Order is received
you will be sent a registration file for the program.  Put that file
on a floppy diskette and follow the same instructions in step 1 above.

Log In Screen

Enter the following information:

ID: BK (press enter)

Password: PASSWORD <Enter>

This is the ID and Password for the Bookkeeper. There is also another
login ID included which is assigned to the System Administrator.  If
you do not have a System Administrator you can contact our Support
Group to obtain this login ID which will give you unlimited access to
any of the file security programs.

You can change the password, under the 'Change Password' option of the
Utilities Menu.

Daily Start Up

To start the program, select the School Accounting icon within the
EPES Software Group of your Windows Program Manager.

Enter your ID: BK  and
Password: PASSWORD

(The Password can be changed at any time under the “Utilities
Section”.)
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CHAPTER 2

File Menu

This chapter explains how to set up your Basic Accounting Program and
begin adding information under the File Menu.

Setting Up the Basic Accounting Program

Use the following steps to set up your program:

STEP 1 - Get to the Master Menu
Select the School Accounting icon from your Windows Program Manager to
start the program.

Enter the following information:

ID: BK (press enter)
(or the ID that has been set up for you.)

Password: PASSWORD
(or the password you have set up for you.)

The Master Menu will appear at the top of the screen:

STEP 2 - Enter your Program Preferences
Select 'Program Preferences' under the Utilities Menu. Complete the
information on the screen as explained under the heading "Program
Preferences" in Chapter 4 of this manual.

STEP 3 - Assign Activity (Fund) Accounts
Your Activity Accounts tell you who can spend or receive money.  These
might include: Football, Band, Student Council, General Fund, Candy
Store, and Interest Income.

Note: For basic Fund Accounting, use the Activity Accounts as a Fund
Code. It's recommended that you do not mix activity and fund
accounting in the same program. If you want to use the program for
both activity and fund accounting, install the program twice, in
separate subdirectories. One for activity accounting and the other for
fund accounting. For example:
C:\ACTW for activity accounting
C:\FUNDW for fund accounting
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Take time NOW to organize your accounts. The best way to do this is by
grouping your accounts according to the activity or use. Please review
the following examples:

Group 1   (Accounts 100-199)

• 100 General Fund
For all funds not tied to a specific activity or club.

• 110 Vending Machine
For vending Machine Sales.

• 120 School Supplies
For school supplies sales, expenses, etc.

Group 2   (Accounts 200-299)

• 200 General Athletics
For all general athletic funds.

• 210 B/Basketball
For boys basketball.

• 220 G/Basketball
For girls basketball.

Group 3   (Accounts 300-399)
Might be for student clubs, like student council.

Group 4   (Accounts 400-499)
Might be for band or band related activities.

Group 5   (Accounts 500-599)
Might be for trips or travel.

Group 6   (Accounts 600-899)

• 800 Misc. Income/Expenses

• 810 Interest earned on investments

Leave some blank account numbers between your groups. This allows you
to add more accounts to your group later.

Use the chart on the next page to assign the account number, name,
beginning balance, and advisor. You can make additional copies of the
chart.

Activity/Fund Accounts

Act#/Fund| Name         |Beg. Balance |Act.Advisor
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_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________
_________|______________|_____________|___________

STEP 4 - Assign General Ledger Accounts
Your General Ledger Accounts tell you  where the money is located.
We've provided five General Ledger Accounts below so we can be
consistent in providing support to you. Don't change them, unless you
have a very good reason to do so.

Account # Account Name
990 Petty Cash
991 Cash On Hand
992 Checking Account
993 Savings Account
994 Investments

Complete the following chart.



Chapter 2: File Menu

2 - 4

General Ledger Accounts.

Acct#  Name              Beginning Balance
990    Petty Cash                       
991    Cash On Hand                     
992    Checking                         
993    Savings                          
994    Investments                      
                                        
                                        
                                        

STEP 5 - Add Your Activity Accounts
Select 'Accounts' under the File Menu. Then, select 'Activity
Accounts'.

Select < Add >.

Account:
Enter a unique account number for this activity (or fund) and press
[Tab]. For example: 100.

Account Name:
Enter a complete description of the Account and press [Tab]. For
example:  General Fund

Advisor:
Enter the name of the activity advisor, if any, for this account and
press [Tab].
For example:  John Wilson

Beg. Balance:
Enter the beginning balance for this account and press [Tab].
For example:  2475.12

Select < Save and keep adding > to continue adding your Accounts.

When you've finished, click ‘Close’ to return to the Master Menu.

Note: The cash balance will change as you enter receipts and
disbursements. The payable balance will change as you add to accounts
payable. The Encumbered balance will change as you enter Purchase
Orders.

STEP 6 - Add General Ledger Accounts
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Note: General Ledger Accounts 990-994 are automatically created when
you install the program. To change these accounts, select
< Edit > instead of < Add >.

Be sure you enter the correct beginning balance for you checking
account and other General Ledger accounts.

Select 'Accounts' under the File Menu. Then, select 'General Ledger
Accounts'.

Select < Add >.

GL Account:
Enter a unique account number for this General Ledger Account and
press [Tab]. For example: 996.

Account Name:
Enter a complete description of the General Ledger Account and press
[Tab].
For example:  NSF Checks

Beg. Balance:
Enter the beginning balance for this account and press [Tab].
For example:  0

Note: Click on the Check box with the mouse [ ] to mark a General
Ledger Account as a checking account: [X] Checking Account

Select < Save > or < Save & keep adding >.

When you've finished, ‘click Close’ to return to the Master Menu.

STEP 7 - Record Sub-Accounts
Use sub-accounts only if you need a more detailed break down of your
transactions or budget.

A single sub-account will be used by all accounts. For example: 510
could be Uniforms for football, basketball, band, etc.

Select 'Accounts' under the File Menu. Then, select  'Sub Accounts'.

Select < Add >.

Note: Sub-Account 0 (No Sub-Account) is automatically created when you
install the program.

Sub Acct:
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Enter a unique number for the sub-account. For example: 510.

Sub Name:
Enter a description of the sub-account. For example: Uniforms.

Select < Save > or < Save and Keep Adding >.

When you've finished, click ‘Close’ to return to the Master Menu.

Note: If you're using the Extended Code module, add Expense and
Revenue Codes in the same manner, as needed.

STEP 8 - ADDING VENDORS
Use this option to record information about your vendors.

Select 'Vendors' under the File Menu.
Select < Add >.

Note: Record the first vendor as blank, so items with no vendors can
be entered.  Optionally, you can write checks to persons you do not
want to set up as Vendors by using the blank Vendor Code and putting
their name on the Note line when entering Accounts Payables.

Vendor Code:
Enter a short abbreviation (vendor code) to describe the vendor. For
example: WALM.

Vendor Name:
Enter the full name of the vendor. For example: Walmart.

Attention:
Enter the name of the person at the company whose attention you want.

Address:
Enter the address of the vendor. For example: 2105 Beach Street.

P.O. Box:
Enter the P.O. Box of the vendor. For example: P.O. Box 749

City:
Enter the name of the city where the vendor resides. For example:
Magnolia.

State:
Enter the two digit abbreviation for the state where the vendor
resides. For example: AR.
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Zipcode:
Enter the vendor's zipcode. For example: 71753.

Telephone:
Enter the vendor's telephone number, area code first. For example:
501-234-1234.

Fax:
Enter the vendor's fax number, area code first. For example: 501-234-
1230.

Tax Id No:
Enter the vendor's Tax ID number or social security number. For
example: 71-1234567.

Bid Categ:
Optional. Use this item to identify the kinds of items the vendor
supplies. To do this:

1. Develop some unique bid codes. Use one digit (letter or number)
codes.  For example: A= Audiovisual

C= Computer Equipment
E= Electronic Equipment

2. Determine the items this vendor supplies.

3. Enter the codes for the items this vendor supplies. For example: CE
would mean computers and electronic equipment.

Memo:
Use this field to enter information about this vendor that will help
you in the future.

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu)
Select < Save and keep adding > to save this vendor and add another
one.

Select < Save > to save this vendor.

Select < Cancel > to undo what you've added.

When you've finished adding vendors, select < Close > to return to the
Master Menu.

CHECK YOUR BALANCES AT THIS POINT:
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You have now entered all your Master Record data.  Verify your
balances and add any outstanding checks and/or deposits prior to
continuing.

Outstanding Checks
If you have any outstanding checks, enter them under 'Checks Paid' of
the File Menu.

Use the same account number you used when these checks were written.
The date of these outstanding checks must be prior to the beginning of
your fiscal year. When you try to enter these outstanding checks, you
will get the message:

Warning! __/__/__ is out of the current Fiscal Year

This is OK. Enter all your outstanding checks. When you've finished,
click ‘Close’ to return to the Master Menu.

Finally, select 'Current Balances' under the Utilities Menu to make
sure all balances are current.

Outstanding Deposits
Normally, you don't have an outstanding deposit. However, if you do
select 'Receipts' under the File Menu.

You'll be prompted to "Select an Account". You should select your
checking account.

Add a receipt for the total of your outstanding deposit. This is
necessary for your to be able to reconcile your bank statement. Use a
date PRIOR to the beginning of your fiscal year.

Once all outstanding entries are entered,
select 'Current Balances' under the Utilities Menu.

Print Ledger Report
Select 'Ledger Report' under the Output Menu.

Press [Tab] for Report Title.

Enter the beginning date of your report. For example: 07/01/96

Enter the ending date of your report. For example: 07/31/96

Select < OK > to print the report to the screen. Check the beginning
balances on the report.

Note: The total amount of money under the beginning balance must be
the same for both your Activity Accounts and your General Ledger
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Accounts. Otherwise, you're out of balance before you even get
started.

Remember, the Activity Accounts tells you who can spend the money.
For example: band, football, basketball, etc.

The General Ledger Accounts tell you where the money is. For
example: checking account, cash on hand, petty cash, etc.

To make any corrections to your beginning balances, return to the
Master Menu.

Select 'Accounts' under the File Menu.

Select either 'Activity Accounts' or 'G.L. Accounts'.

Get the account in question on the screen and edit it.  Make any
corrections in your beginning balances.

STEP 9 - Extended Code Program Module
Some states require additional expense or revenue codes. If you're
using the Extended Code program module, see the "Extended Code
Preference" section in Chapter 4 of this manual for details on setting
up your extended codes.

ADDING INFORMATION

Use the following steps to add information using the File Menu of your
program:

STEP 1 - Adding Receipts
Select 'Receipts' under the File Menu.
Press [Tab] to select "Cash on Hand".

Note: Each receipt posted will be entered into your General Ledger
Account called "Cash on Hand". At the end of the day, when you make
your bank deposit, select 'Transfers & Deposits' under the File Menu
then ‘Record Bank Deposit’ to automatically post your receipts to your
checking account. This will greatly simplify your bank reconciliation
at the end of the month and provide a detailed audit trail.
(See Chapter 6, Questions and Answers)

Select < Add >.

Recpt No:Press enter or enter new number.

Date:
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Press [Tab] to accept the current date or, enter the correct date and
press [Tab].

Vendorcode (Received From):
Enter the vendor's code and press [Tab] or press [F5] to select from a
popup vendor list. For example:  WALM.

Add new line item:
Press [Enter] to add a detail (stub) line to this receipt.

Account:Enter # or [F5] to select from popup.

Sub-Acct:
Press [Tab] for no sub-account or enter the Sub-Account code. Press
[F5] to select from a popup list of sub-accounts.

Revenue Codes:

Note: These fields will be skipped unless you're using the Extended
Code program module and have marked them for use. See the Extended
Code Preference option in Chapter 4.

Enter any revenue code(s). If you don't know the revenue codes, press
[F5] to select from a popup list.

Note:
(Optional) Enter a brief description for this item. For example: Car
Wash

Amount:
Enter the amount received. For example: 39.50

Add another line item, Save, Cancel: (Receipt Detail)
Select < Add another line item > to add another line item. Five is the
limit for receipt items.
Select < Save line item & exit> to save your line item(s).
Select < Cancel line item > to undo what you've added and exit.

Note: If you've added more than one receipt line item, you'll be asked
whether to cancel the last item entered or all line items.

When you return to the receipt screen, use the Tool Bar Menu at the
top of the screen.

Save and keep adding, Save, Cancel: (Tool Bar Menu)
Select < Save and keep adding > to save this receipt and add another
receipt.
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Select < Save > to save the current receipt.

Select < Cancel > to undo what you've added and exit.

When you've finished adding receipts, select < Close > to return to
the Master Menu.

Print Receipt
If you marked the "Print Receipts while adding" box in the Program
Preferences screen, the receipt will print when you select < Save and
keep adding > or < Save > from the Tool Bar Menu at the top of the
screen. Otherwise, click on the < Print Receipt > button with the
mouse to print a copy of the receipt currently displayed on the
screen.

Receipt Browse Detail
Click on this button to view the detailed line item (stub) information
of your receipts.

This option is very helpful in looking up information contained in
your receipt detail. For example: if you wanted to find the receipt
where you'd paid $37.75 in activity account 100:  Select < Browse
Detail >, then use the Find option (from
the Tool Bar) to look up an "Amount" equal to 37.75. Browse through
the Find window.

When you've found the item, press [Esc] to exit and return to the
Receipt Screen.

The entire receipt information you selected will be displayed on the
screen.

Note: See Chapter 3 of the EPES Reference manual detailed information
on the Find option.

STEP 2 - ADDING DISBURSEMENTS
Use this option to record disbursements so the program can print your
checks. Select 'Accounts Payable' under the File Menu. Select Add.

Date:
Press [Tab] to select the current date or type in the correct date and
press [Tab].

Vendorcode (PAY TO):
Enter the vendor's code and press [Tab].
For example:  WALM.

Add new line item:
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Press [Enter] to add a detail (stub) line to this payable.

Account:
Enter the Activity Account or press [F5] to select from a popup list
of accounts. For example: 100  (for General Fund)

Sub Acct:
Enter the Sub-Account code. Press [Tab] for no sub-account.

Expense Codes:

Note: These fields will be skipped unless you are using the Extended
Code program module and have marked them for use. See Chapter 4
"Extended Code Preferences" for details.

Enter any expense codes. If you don't know the expense code, press
[F5] to select from a popup list.

Note:
(Optional) Enter a brief description for this payable. For example:
Car Wash
Purchase:
Press [Tab] or type in a purchase order number.
Invoice:
Press [Tab] or type in an invoice number.
Amount:
Enter the amount for this payable line item.
Tax Amount:
Press [Tab] unless this item involves a taxable item. Then, enter the
amount of sales tax for this item.

Note: The tax amount is included in the amount for this line item.

[ ] Mark for 1099:
Click with the mouse to mark this disbursement for 1099 reporting.

Add another line item, Save line item & Exit, Cancel Line item:
(Detail)
Select < Add another line item > to add another line item. Fourteen
line items is the limit for payables.

Select < Save line item & exit > to save your line item(s).

Select < Cancel line item > to undo what you've added and exit.

Note: If you've added more than one payable line item, you'll be asked
whether to cancel the last item entered or all line items.
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When you return to the payable screen, use the Tool Bar Menu at the
top of the screen.

Save and Keep adding, Save, Cancel: (Tool Bar Menu)
Select < Save and keep adding > to save this payable and add another
payable.

Select < Save > to save the current payable.

Select < Cancel > to undo what you've added and exit.

When you've finished adding payables, select < Close > return to the
Master Menu.

Multiple Items Paid to Same Vendor
If you want multiple entries to be paid to the same vendor, instead of
adding a new account payable entry, get the account payable entry on
the screen for the vendor you want to pay. Click on the <Add another
line item > button at the bottom of the screen just above the message
'(Payable Detail)'. Add the new item here. Then, when the check is
printed, it will appear on the same check. You can add up to 14 items
on one check.

Payable Browse Detail:
Click on this button to view the detailed line item (stub) information
for your payables.

This option is very helpful in looking up information contained in
your payable detail. For example: let's suppose you wanted to find the
payable where you'd paid $37.75 in activity account 100.

Select < Browse Detail >, then use the Find option (from the Tool Bar)
to look up an "Amount" equal to 37.75. Browse through the find window.
When the line item you're looking for is on the screen, press [Esc] to
exit and return to the Payable Screen. This payable will be displayed
on the screen.

Note: See Chapter 3 of the EPES Reference manual for detailed
information on the Find option.

STEP 3 - Adding Disbursements Manually
Use the ‘Checks Paid’ option to record disbursements without printing
checks. Select 'Checks Paid' under the File Menu. Select < Add >.

Check No:
Enter the number of the check.
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Date:
Enter the date of the check and press [Tab].

Vendorcode (PAY TO):
Enter the vendor's code and press [Tab].
For example:  WALM.

Add New Line Item:
Press [Enter] to add a detail (stub) line to this check.

Enter the Activity Account or press [F5] to select from a popup list
of accounts. For example: 100  (for General Fund).

Sub Acct:
Enter the Sub-Account code. Press [Tab] for no sub-account.

Expense Codes:

Note: These fields will be skipped unless you're using the Extended
Code program module and have marked them for use under Extended Code
Preference option. See Chapter 3 for details.

Note:
(Optional) Enter a brief description for this check. For example: Car
Wash

Purchase:
Press [Tab] or type in a purchase order number.

Invoice:
Press [Tab] or type in an invoice number.

Amount:
Enter the amount for this line item check.

Tax Amount:
Press [Tab] unless this item involves a taxable item. Then, enter the
amount of sales tax for this item.

Note: The tax amount is included in the amount for this line item.

[ ] Mark for 1099
Click with the mouse to mark this disbursement for 1099 reporting.

Add another line item, Save line item & exit, Cancel line item:
(Detail)
Select < Add another line item > to add another line item. Fourteen is
the maximum line items.

Select < Save line item & exit > to save your line item(s).
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Select < Cancel line item > to undo what you've added and exit.

When you return to the check screen, use the Tool Bar Menu at the top
of the screen.

Save and keep adding, Save, Cancel: (Tool Bar Menu)
Select < Save and keep adding > to save this check and add another
check.

Select < Save > to save your current check.

Select < Cancel > to undo what you've added and exit.

Checks Browse Detail:
Click on this button to view the detailed line item (stub) information
of your checks.

This option is very helpful in looking up information contained in
your check detail. For example: let's suppose you wanted to find the
check where you'd paid $37.75 in activity account 100.

Select < Browse Detail >, then use the Find option (from the Tool Bar)
to look up an "Amount" equal to 37.75. Browse through the Find window.
When the line item you're looking for is on the screen, press [Esc] to
exit and return to the Check Screen. This check will be displayed on
the screen.

Note: See Chapter 3 of the EPES Reference manual for detailed
information on the Find option.

ADDING TRANSFERS & DEPOSITS:

Use this option to:

(1) record your bank deposit at the end of the day,

(2) transfer funds between different Activity Accounts, and

(3) transfer funds between different General Ledger Accounts.

Select 'Transfers & Deposits' under the File Menu.

STEP 4 - RECORD BANK DEPOSIT
Select 'Record Bank Deposit' under Transfers & Deposits. This option
automatically transfers money into your checking account.
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As money is received daily, it normally is received into the "Cash on
Hand" General Ledger Account. Then, at the end of the day, the money
is deposited into the school checking account.

If you follow the suggestion above and receive your money into Cash on
Hand each day, it will greatly simplify your bank reconciliation at
the end of the month!
See Chapter 6 Questions & Answers.

Deposit Date:
Enter the date of the deposit.

Deposit Money From:
This option tells the computer where the money is currently located.
Generally, this account will be 991 (Cash on Hand).

The default General Ledger Account to receive the money is 992
(Checking Account).  If you have multiple Checking Accounts you will
be prompted to select which Checking account is to receive the money.

Deposit Amount:
The amount of money presently in the account you selected will appear.
To transfer all this money to your checking account press [Tab]. If
you want to leave some of your money in cash on hand, enter the amount
of your deposit.
Description:
Enter a brief description for this transaction. For example: Daily
Deposit.

Note: This option posts an entry into your GL Transfer File.

Click on < OK > to record the bank deposit.
STEP 5 - ADDING GENERAL LEDGER TRANSFER
Select 'General Ledger Transfer' under Transfers & Deposits. This
option transfers money from one General Ledger Account to another. It
also allows you to view General Ledger transfers.

This allows you to change the place where your money is located. For
example: you want to transfer money from your checking account to your
savings account.

Select < Add>.

Date:
Press [Tab] to accept today's date or type in the correct date of the
transfer.

From Acct:
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Enter the General Ledger Account number where the money is currently
located or press [F5] to select from a popup list of accounts. For
example: 992 Checking.

To Acct:
Enter the General Ledger Account number where the money is being
transferred to, or press [F5] to select from a popup list of accounts.
For example: 993 Savings.
Amount:
Enter the amount of money to be transferred. For example: 2500.
Document:
Optional, enter a reference number for this transfer.
Note:
Enter a brief description of this transfer. For example: To - CD
#1012.

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu)
Select < Save and keep adding > to save this G.L. Transfer and add
another one.

Select < Save > to save this G.L. Transfer.

Select < Cancel > to undo what you've added.

When you've finished, select < Close > to return to the Master Menu.

STEP 6 - ADDING ACTIVITY ACCOUNT TRANSFERS
Select 'Activity Account Transfer' under Transfers & Deposits. This
option transfers money from one activity fund account to another. It
also allows you to view activity account transfers.

This lets you change who can spend the money. For example: you want to
transfer money from your general Athletic account to your Football
account.

Select < Add >.

Date:
Press [Tab] to accept today's date or type in the correct date of the
transfer.

From Account:
Enter the Activity Account number where the money is currently located
or press [F5] to select from a popup list of accounts. For example:
100 General.

Sub-Account:
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Press [Tab] to select no sub-account or type in the sub-account for
this money.

From Expense Codes:

Note: These fields will be skipped unless you're using the Extended
Code program module and have marked them for use. See Chapter 4
"Extended Code Preference" for details.

Enter any From Expense code. If you don't know the extended code,
press [F5] to select from a popup list.

To Account:
Enter the Activity Account number where the money is being transferred
to or press [F5] to select from a popup list of accounts. For example:
20 Athletics.

Sub-Account:
Press [Tab] to select no sub-account or type in the sub-account for
this money.

To Expense Codes:

Note: These fields will be skipped unless you're using the Extended
Code program module and marked them for use. See Chapter 4 "Extended
Code Preference" for details.

Enter any To Expense code. If you don't know the extended code, press
[F5] to select from a popup list.

Amount:
Enter the amount of money to be transferred. For example: 100.

Document #:
Optional, enter a reference number for this transfer.

Note:
Enter a brief description of this transfer. For example: Transfer to
Football.

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu)
Select < Save and keep adding > to save this Activity Transfer and add
another one.

Select < Save > to save this Activity Transfer.

Select < Cancel > to undo what you've added.
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When you've finished adding transfers, select < Close > to return to
the Master Menu.

STEP 7 - RECORD A BUDGET (Optional)
Use this option to record a budget for each account.

Select 'Budget' under the File Menu.
Select < Add >.

Account:
Enter the Activity Account number or press [F5] to select from a popup
list of accounts.

Sub-account:
Press [Tab] if the Activity Account has no sub-account.

Enter the sub-account number or press [F5] to select from a popup
list.

Budget:
Enter the budget amount for this Activity Account.

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu)
Select < Save and keep adding > to save this budget entry and add
another one.

Select < Save > to save this budget entry.

Select < Cancel > to undo what you've added.

When you've finished, select < Close > to return to the Master Menu.

STEP 8 - ADDING VENDORS
Use this option to record information about your vendors.  Initial
Vendor information should be added immediately after setting up
Accounts.

Select 'Vendors' under the File Menu.
Select < Add >.

Note: Record the first vendor as blank, so items with no vendors can
be entered.  Optionally, you can write checks to persons you do not
want to set up as Vendors by using the blank Vendor Code and putting
their name on the Note line when entering Accounts Payables.
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Vendor Code:
Enter a short abbreviation (vendor code) to describe the vendor. For
example: WALM.

Vendor Name:
Enter the full name of the vendor. For example: Walmart.

Attention:
Enter the name of the person at the company whose attention you want.

Address:
Enter the address of the vendor. For example: 2105 Beach Street.

P.O. Box:
Enter the P.O. Box of the vendor. For example: P.O. Box 749

City:
Enter the name of the city where the vendor resides. For example:
Magnolia.

State:
Enter the two digit abbreviation for the state where the vendor
resides. For example: AR.

Zipcode:
Enter the vendor's zipcode. For example: 71753.

Telephone:
Enter the vendor's telephone number, area code first. For example:
501-234-1234.

Fax:
Enter the vendor's fax number, area code first. For example: 501-234-
1230.

Tax Id No:
Enter the vendor's Tax ID number or social security number. For
example: 71-1234567.

Bid Categ:
Optional. Use this item to identify the kinds of items the vendor
supplies. To do this:

1. Develop some unique bid codes. Use one digit (letter or number)
codes.  For example: A= Audiovisual

C= Computer Equipment
E= Electronic Equipment

2. Determine the items this vendor supplies.
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3. Enter the codes for the items this vendor supplies. For example: CE
would mean computers and electronic equipment.

Memo:
Use this field to enter information about this vendor that will help
you in the future.

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu)
Select < Save and keep adding > to save this vendor and add another
one.

Select < Save > to save this vendor.

Select < Cancel > to undo what you've added.

When you've finished adding vendors, select < Close > to return to the
Master Menu.

STEP 9 - CANCEL CHECKS
Use this option to cancel checks at the end of the month.

Select 'Cancel Checks' under the File Menu.

Date Cancelled:
Enter the cancellation date to use.

The items to be canceled are in the window to the left of the screen.

To cancel an entry:

• Use the Up and Down arrow keys to highlight the entry and press
[Enter].

   or
• Double click on the entry with the mouse.

Notice the double arrows  >>  appears in the left hand column. This
shows the item has been canceled. Repeat the same options above to
unmark the entry.

Note: Notice the total changes as you mark each entry to cancel.
(See Chapter 6, Questions and Answers)

• Press [Tab] and [Tab] or click on [OK] with the mouse when done.

Correcting a Canceled Check Date
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If you accidentally cancel a check by mistake, do the following to
correct it:

• Select 'Checks' under File Menu.

• Get the check on the screen that should not have been canceled.

• Hold down the Alt key and press the letter U [Alt+U]. This will
automatically erase the cancellation date for you.

Step 10 - Counties:
Use this option to enter County Id’s if required by your state for tax
reporting by county.
Select ‘Counties’ under the file menu, click ‘Add’.
County Id:  Enter the correct County Id.
County Name:  Enter the County name.
Save and keep adding, Save, Cancel <tool bar menu.
Select <Save and keep adding> to save this county and add another.
Select <Save> to save this county and quit adding.
Select <Cancel> to undo what you’ve added (last entry only)
When you’ve finished adding Counties, select <Close> to
return to the Master Menu.

Step 11 - Journal Adjustments:
Use this option to record Journal Voucher type entries,
ie. NSF Checks, Interest Earned, Bank Charges, etc..
Select ‘Journal Adjustments’ under the File Menu.
Select <Add>
Adj. No:  Enter your Adjustment number.  The system will auto-
matically increment this number for each subsequent entry.
Date:  System will default to current date.  You may change if
necessary.
Account:  Enter the Activity Account to be used.
GL Account:  Enter the proper G.L. Account number.
Sub Account:  Enter the sub account if applicable
Amount:  Enter the transaction amount (Do not use negative amts.)
Type Adjustment:  Enter either I (Income) or E (Expenditure).
    Note:  Type “E” will automatically decrease Account Balances.
           Type “I” will automatically increase Account Balances.
Note:  Use this field to record additional information.
AUTH By:  Enter initials or name of person authorizing this entry.
After all information is entered select:
‘Save and keep adding’ (To add another record), ‘Save’ (To save

current record) or ‘Cancel’ (To cancel record just added).
Then ‘Close’.
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CHAPTER 3

OUTPUT
(Reports)

This chapter explains the Standard Reports to print to the screen or
printer.

Note: This option is Not highlighted if you are viewing information on
the screen. (That means you can't use it.) Quit what you're doing and
return to the Master Menu.

The standard reports are:

• Ledger Report
• Reconciliation Report
• Outstanding Checks
• Bank Reconciliation
• Vendor Listing
• Chart of Accounts
• Sequential Listing
• 1099 Information
• Sub-Account Reports
• Print Checks
• Trial Balance
• Journal Adjustments
• Special Financials
• Deposit Voucher

Select Output from the Master Menu.

Ledger Report

This report prints the totals for each account. It lists the beginning
balances, ending balances, total receipts, disbursements, and
transfers.

Select 'Ledger Report' under the Output Menu.
Answer the following questions:

From Date:
Enter the beginning date for this report. For example: 07/01/2000

To Date:
Enter the ending date for this report. For example: 07/31/2000

From Account:
Press [Tab] if 1 is the lowest account to include on this report or
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enter the lowest account to include on this report.

To Account:
Press [Tab] if 999999 is the highest account to include on this report
or enter
the highest account to include on this report.

(•• ) Financial Report
( ) Year to Date + Current Month
( ) Budget Ledger

Select the type ledger report to print

The Financial Report is the Standard Ledger Report.

The Year to Date report prints the total receipts, disbursements, and
transfers for the current month and the year to date totals for each
account.

The Budget Ledger report prints the total receipts, disbursements, and
transfers for the current month and the year to date totals for each
account and sub-account. It also includes the total budget and amount
spent for each account and sub-account.

Summarize on which digit of the Account #:
Use this option to print a summary report for groups of accounts.

Let's look at an example. Remember all accounts, are 6 digits. Suppose
you grouped your accounts like:

100 - General Fund
110 - Vending Machine

200 - Athletics
210 - Basketball
220 - Football, etc.

The account numbers will print in the following order:
000100
000110
000200
000210
000220

-------------------------
Digit # => 123456

If you entered the number 4 (fourth digit moving from left to right)
as the digit to summarize on, you would get subtotals for your 100
accounts, 200 accounts, etc. (The program will give you a subtotal
when the digit you selected changes.)
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(•• ) Print to Screen
( ) Print to Printer

Select where you want your report to print.

Click on < OK >.

Reconciliation Report

This report prints the beginning balance for the date of the report.
It then lists each receipt, disbursement, and transfer in separate
columns.

Print this report as required. It is an item-by-item, account-by-
account, audit trail.

Select 'Reconciliation Report' under the Output Menu.

Answer the following questions:

From Date:
Enter the beginning date for this report. For example: 07/01/2000

To Date:
Enter the ending date for this report. For example: 07/31/2000

From Account:
Press [Tab] if 1 is the lowest account to include on this report or
enter the lowest account to include on this report.

To Account:
Press [Tab] if 999999 is the highest account to include on this report
or enter the highest account to include on this report.

[ ] Separate page for each account.
Press [P] to print a separate page for each account. The advisor's
name will appear at the bottom of each account. It may take a lot of
paper to print this report.

By default, this report will print one account after another. There
will be no advisor's name on the report.

(•• ) Print to Screen
( ) Print to Printer

Select where you want your report to print.
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Click on < OK >.

Outstanding Checks

This report prints a list of all outstanding checks for your selected
checking account.

Select 'Outstanding Checks' under the Output Menu.

Answer the following questions:
Print Outstanding checks as of __/__/____
All checks, not cancelled on or prior to this date, will print.

(•• ) Print to Screen
( ) Print to Printer

Select where you want your report to print.

Click on < OK >.

Bank Reconciliation

This report prints a bank reconciliation for your checking account.

Select 'Bank Reconciliation' under the Output Menu.

Answer the following questions:

Beginning Statement Date:
Enter the beginning date of your bank statement. For example:
07/01/2000

Ending Statement Date:
Enter the ending statement date for your bank statement. For example:
07/31/2000

Ending Balance from Bank Statement:
Enter this balance from your bank statement.

Total Deposits not on Bank Statement:
Enter the amount of deposits made that do not appear on the bank
statement, if any.
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(•• ) Print to Screen
( ) Print to Printer

Select where you want your report to print.

Click on < OK >.

Vendor Listing

This reports prints a list of vendors. It uses the Report Query
format.

Select 'Vendor Listing' under the Output Menu.

Select < PreView > to view the report on your screen.

Select < Print > to print this report to your printer.

See the EPES Reference manual, Chapter 4, to learn how to limit the
information printed and save your work for later use.

Chart of Accounts

This report prints a list of Activity Accounts, General Ledger
Accounts, or Sub-Accounts.

Select 'Chart of Accounts' under the Output Menu.

Select your report listing: Accounts, GL Accounts, or Sub-Accounts
Codes.

Select PreView to print to the screen.

Select Print to print to your printer.

See the EPES Reference manual, Chapter 4, to learn how to limit the
information printed and save your work for later use.

Sequential Lists

This report prints sequential lists for Checks, Receipts, Transfers,
or Accounts Payable.

Select 'Sequential Lists' under the Output Menu.

Select your report: Checks, Receipts, Activity Transfers, General
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Ledger Transfers, Accounts Payable, Tax Amounts by County or All
Transactions.

All reports use the Report Query format. See the EPES Reference
manual, Chapter 4, to learn how to limit the information printed and
save your work for later use.

Select PreView to print the report to the screen.

Select Print to print the report to your printer.

Select Done to return to the Master Menu.

1099 Information

This report prints 1099 tax information. The information for the first
six months of the year (assuming your fiscal year begins on July 1) is
taken from the sub directory PREVYEAR. This directory contains the
previous year's information. The last six months of the year is taken
from your current directory.

Select '1099 Information' under the Output Menu.

Answer the following questions:

(•• ) 1099 Report (prints on plain paper)
( ) 1099 Forms (prints on 1099 Misc. Form)
( ) 1099 Export File

Select the report you want.

Note: 1099 Export File prints information to a disk file. This file
may be sent to a central office for processing.

A prompt to the right of the Export File will appear. Enter the disk
drive and path name for the 1099 disk file. For example:
A:TAX_1099.TXT
Be sure you have a formatted diskette ready in the drive you specify.
(See Chapter 6, Questions and answers)

Answer the following questions, as prompted. The questions you're
asked will depend on the report you request.

Employer Name, Address...
Enter the school's address. For example:
Magnolia School District
1000 School Drive
Magnolia,  AR  71753
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Employer's Federal Identification #:
Enter the schools federal identification number. For example: 71-
1234567

Minimum Dollar Amount:
Enter the minimum amount of money required for a vendor to receive a
1099 report form. For example, 600.

Note: If you're using the Export File option to send your 1099
information to a central office, leave the minimum amount as zero.
This allows the central office to accumulate totals for vendors who
worked at more than one site.

(•• ) Print to Screen
( ) Print to Printer

Select where you want your report to print.
Click on < OK >.

Sub-Account Reports

This report prints check, receipt, JV and Transfer information by sub-
account. It uses the Report Query format. See the EPES Reference
manual, Chapter 4, to learn how to limit the information printed and
save your work for later use.

Select 'Sub-Account' under the Output Menu.

Select your report:

Select PreView to print the report to the screen.

Select Print to print the report to your printer.

Select Done to return to the Master Menu.

Print Checks

This option uses the information posted in Accounts Payable to print
the checks on your computer.

Note: Contact TBF, Inc. @ 877-325-0189 for questions about checks or
receipts.

Select 'Print Checks' under the Output Menu.
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More than One Checking Account:
If you have more than one checking account, you'll be prompted to
select the checking account to print checks from.

Holding Accounts Payables from Payment
The check writer prints all checks marked [X] in the Accounts Payable
file. If you do not want an Accounts Payable entry to be paid, do the
following:

• Select 'Accounts Payable' under the File Menu.

• Get the Payable entry on the screen that you do not want to pay.

• Hold down the Alt key and press the letter M [Alt+M]. This will
unmark the  [ ] Pay this box. Press [Alt+M] again to mark this item
for payment.

(•• ) Print Checks with Payable Dates Through:
Press [Tab] to print checks with payable dates through the current
date or type in the last date to consider for entries posted in the
Accounts Payable file.

Next Check#:
Press [Tab] if this is the next check number to use. If not, enter the
correct check number.

Date to Print on Checks:
Press [Tab] to accept today's date or type in the date to be printed
on the checks.

[ ] Print check Numbers on check:
Press [N] (or press the spacebar while this is highlighted) to tell
the program to print the check number on your check.
Press [Tab] if your checks are pre-numbered.

[ ] Combine Checks to same Vendor:
Select this option to combine all checks to same Vendors

[ ] Post Checks without printing:
This option will post checks from A/P to Checks Paid.  Checks will be
removed from Payable.

[ ] Use Note line for Payee (Blank Vendors)
If you have used Blank Vendor Codes in Payables, this option will
print the information on the Note Line as the Payee.

PreView Checks:
Click on this option to see the checks on the screen before printing
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them.

Print Checks:
Press [P] or click on this option to print checks to your printer.

The program will ask you if the first check printed correctly.  This
will give you an opportunity to verify printer alignment.
When the checks have finished printing, the program will ask you:

Did the Checks print correctly?
< Yes >    < No >

Click with the mouse to select your option. The program will then post
the checks printed from accounts payable to checks. All account
balances will be updated.

If you had a problem printing,  select
< No >.  All information will remain in accounts payable and no
changes will occur in balances. You'll have to select the Print Check
option again to print the checks.

Note: If you use pre-numbered checks and had problems printing, enter
any bad or voided checks manually in 'Checks Paid' under the File
Menu. Enter the amount of the check as zero.

Use the same date for cancellation as you used for the check. This
will provide an audit trail.

Cancel:
Press [C] or click on this option to cancel all check writing and
return to the Master Menu.

Trial Balance:
This option prints a Trial Balance Report displaying all Debits and
Credits entered for each Account.

Journal Adjustments:
This option prints a listing of all Journal Adjusting entries.  Select
either Activity or G.L. Adjustments.
Report includes:
Date, Account, Sub Acct., Adjustment number, Auth. By, Income or
Expense
and Amount.
A total line is printed for both Income and Expense entries.

Special Financial Report:
This report combines the information from the Bank Reconciliation
Report and the Summary Ledger Report.  Each Account is shown with all
transactions for a specific time period; plus, the Bank Reconciliation
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information is included.  Typically, this report is used for special
meetings such as School Board meetings.

Deposit Voucher:
This report is provided as documentation for the daily deposits.  A
listing of all receipts within a specific time period is produced.
This report should be used a supporting documentation for the deposit
slip.



                                                Chapter 4:

4-1

Chapter 4

Utilities Menu

This chapter explains the Utilities Menu programs that are unique to
the Basic Accounting Program. All other Utility Menu programs are
explained in detail in Chapter 6 of the EPES Reference Manual.

Select the Utilities Menu

CURRENT BALANCES TO DISK

Use this option to correct your balances when you've had a computer
problem or power failure.

Select 'Current Balances' under the Utilities Menu.
Select < OK > and the program will automatically re-compute your
account balances.

PROGRAM PREFERENCES

Use this screen to enter some basic program information.

Select 'Program Preferences' under the Utilities Menu.

Beginning Fiscal Year:
Type in the beginning date for your fiscal year. For example,
07/01/2000.

Ending Fiscal Year:
Type in the ending date for your fiscal year. For example, 06/30/2001.

[X] Print Footer on Ledger Report
With this option marked [X], the message on the next five lines will
appear at the bottom of your ledger report.

Press [Tab] to unmark this box if you don't want the message to appear
on your ledger report.

You may change or modify the message as needed. It will print on the
report in exactly the same way it appears in this box.

Format:
Enter a 1 or a 2:
1 = Laser Checks/Receipts
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2 = Dot Matrix Checks/Receipts

Use this option to tell your program what type of printer you're
using.

If you have a Dot Matrix printer, checks and receipts will use a
carbonless copy.

If you have a Laser printer, copies of the check/receipt and stubs
will be printed on each page.

Enable Monthly Close:
Mark this box [X] if you want to use the Monthly Close Option.
(see page 4-5).

Print Receipts while Adding:
Mark this box [X] if you want to print receipts while adding.

Printer Port:
Normally your printer uses printer port LPT1. Select LPT2 or LPT3 if
you're using a different printer port.

CHANGE PASSWORD:
Use this option to change your password.  You will be asked to enter
your current password then to enter your new password twice.  Be sure
to remember your new password

BACKUP/RESTORE:
This option will make a backup copy of all your existing data.  This
option should be run at least 3 times per week.  Optionally; you have
the option to send a copy of your backup data across the network by
checking the “Hard Drive” option and specifing the location you want
the data sent.

EXTENDED CODE PREFERENCES

Note: This option is only available if you purchased the Extended Code
program module.

Some states require additional expense or revenue codes over and above
an account code and sub account code. For example, the state might
require some of the following codes:

1) FY Code
2) Fund Code
3) Function
4) Object
5) Program Code
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6) Subject Code
7) Job Code
8) Site Number

Use the Extended Code module to define these additional codes. The
following information explains how to set them up and use them.

Select 'Extended Code Preferences' under the Utilities Menu.

You can use up to ten categories of expense codes and ten categories
of revenue codes. Think through your coding needs very carefully. Each
category of codes may use up to 10 digits. Therefore, you may use more
than one code per category in some cases.

First, determine the codes you'll need and their logical sequence.
Think of five levels of codes. Put those that do not change or change
less frequently first. For example: FY, Program+Site, Source+Project,
Subject, and Function+Object.

Second, determine which codes will be constant (the same for each
transaction) and which codes will change. For example:

• an FY Code will only change once each year.
•• a Program, Site, Source, and Project, code may rarely change.
•• a Subject, Function and Object Code may change frequently, etc.
Third, if you have more than ten codes, decide which codes may
logically be combined together. For example:

FY Code may be extended code 1. It only changes once each year and
it's the first code required in your logical sequence.
Program and Site may be extended code 2 because they do not change and
they are next in logical sequence.
Source and Project may be extended code 3 because they are constant.
Subject, may be extended code 4 because it occasionally changes.

Function and Object may be extended code 5 because they change
frequently.

Once you've determined your expense and revenue codes and their
logical sequence, use the Extended Code Preference screen to enter
your codes. This screen consists of four columns.

The top portion of the screen is for expense codes. These codes are
used for accounts payable and checks.

The bottom portion of the screen is for revenue codes. These codes are
used for receipts.
Column 1: Mark the box to use the code
If you want to use this extended code group, click on this box with
your mouse. If the box is marked "[X] Use Exp1", you can change
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the information in the remaining three columns. If the box is not
marked, you cannot.
Column 2: Enter a name to use on the screen
Enter the name you want to appear on your screen for this extended
code group. For example: FY Code
Column 3: Enter the number of digits 1-10
Enter the number of digits, 1-10, to use for this extended category.
For example: FY Code would be 1 digit.
Column 4: Enter the default code to use
If this code is constant or does not change very often, enter the code
to use as a default when adding. The program will automatically type
in this code for you when adding.

If there is no consistent code to use, press [Tab].

Note: The number of digits you enter as a default must be equal to the
number of digits defined in column 3. For example, if you entered 3
digits under column 3, you must enter a 3 digit code.

Once you're satisfied with the Extended Codes you've entered, select
<Update Entire Program> at the bottom of the screen. This will update
your entire program with the codes you've defined.

CAUTION: If you've already entered transactions with extended codes
and change the number of digits defined in column 3 above to a smaller
number, you will loose part of the coding information for all entries
previously entered! Be sure you have a backup of your data first!!!

EXTENDED REPORTS

The Extended Reports option is available when you use the Extended
Code program module. It comes with approximately 13 reports already
set up for expenses, revenues, and Payables codes. With this program,
you can:

• Print Journal Reports for Expenses, Receipts, and Payables. This
report prints information in order by extended code groups. When
the codes for any group change, subtotals are printed for each
extended code group.

Note: If you've set up your extended code groups in a logical,
sequential order with those codes which do not change, or change
very little, first and those codes that frequently change last,
this report will give you a detailed summary of exactly where
you've spent or received money for each extended code group.
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• This option also prints a list of all extended expense and revenue
codes.

Registration/Support (See Chapter 5)

END OF YEAR

Use this option when you're ready to close one year and begin a new
year. Be sure you've made current backups.

This option will:

1) Copy all current data files to the PREVYEAR sub directory.

Note: This program maintains two years of data. Be sure you
maintain current backups of all your data and label them
appropriately.

2) Post ending balances for the current year as new beginning
balances.

Select 'End of Year' under the Utilities Menu.
Begfiscal:
Enter the beginning date for your next fiscal year. For example,
07/01/2001.

Endfiscal:
Enter the ending date for your next fiscal year. For example,
06/30/2002.

Select < OK > to end your current year and begin the next year.

Select < Cancel > to exit without making any changes.

Enable Monthly Close:

If you choose to use the Monthly Close Option you will be asked each
time you print a General Ledger Report if you want to “Close Month”
Y/N.  If you respond “Y” all data files associated with this month
will be closed and further access to “Add”, “Edit” or “Delete” will be
denied.  You should be sure that all Accounts balance, Checking
Account is balanced and any changes you need to make to this month has
been completed before responding “Yes” to this question.  Once you
have chosen to close a month it can only be re-opened with the
assistance from your System Administrator or your Technical Support
Group.

Remember: Once a month is closed you cannot make any entry or change
any entry with that months date on it, including Cancel Checks.
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Chapter 5

Registration/Support Menu

This chapter explains the Registration/Support option. Use this menu
to:

1) Register your program after installation

2) Update the support date of your program.

Registering the Program:
To gain unrestricted access to the program you must register it.  To
register a program, do the following:

1.) Purchased from our Sales Office:
Under the Utilities Section select:
‘Registration/Support’, select
‘Register Program’.
If you ordered the program from our office the registration
information is on the CD Rom.  Put the CD Rom in your CD drive. To
register from the CD Rom you will need to check the box marked “Other
Drive Path” and enter your CD Rom drive designation in the box.
Once the appropriate options are entered select ‘OK’.

2)  Registering a Demo program downloaded from our Web Site:
If you downloaded the demo from our web site and subsequently
purchased it you will be sent a registration file for the program.
Put that file on a floppy diskette and follow the same instructions in
step 1 above.

3) Resetting your Support Date:
If you have renewed your support contract and need to change the
support expiration date you will do the following:

Under the Utilities Section select
‘Registration/Support’, select
‘Update Support’
You will receive a code from the support group that you will enter on
the data line.  Once you have entered this code, select ‘OK’.  This
will increase your support contract expiration date by 1 year.

Switch Program Module
When you have more than one program module registered, use this option
to quickly and easily switch from one program to another.  You may
also use the F11/F12 keys.
Select ‘Switch Program Module’ Under
“Switch’ - Select the program module to switch to and then select
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‘OK’.
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Chapter 6

Questions & Answers

This chapter answers commonly asked questions.

How do I delete an Activity Account?

Wait until the end of your fiscal year, if possible.

If you can't wait, determine which account will be deleted and what
account(s) will receive any receipts or checks from the account you're
deleting.

Print a sequential list of all receipts and checks for the account
you're going to delete. Use the beginning date of your fiscal year to
today's date.

This will give you the check or receipt number for each transaction
containing an item for the account you're going to delete.

Use the Find option (while viewing checks or receipts) and search on
Check or Receipt number to get each transaction on the screen.  Update
the account number in each line entry (on the screen) to the new
account number to replace the account you're deleting.

Next, select 'Accounts' under the File Menu. Then select 'Activity
Accounts'.  Use the Find option to get the account you want to delete
on the screen.

The Cash Balance and Payable Balance must be zero.

If the balance isn't zero, select "Current Balances" under the
Utilities Menu.

Again, get the account you're going to delete on the screen. If the
cash balance is not zero, you still have a check or receipt recorded
with the account number.  You cannot delete Accounts that are active
(contains any transaction).

If the payable balance isn't zero, you have an accounts payable entry
with the account number you're going to delete. Change it. If you have
an encumbered amount, you have a purchase order recorded. Change it.

Once the balance is zero, and the Account contains no transactions,
press [Delete] to delete the account shown on the screen.
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What if my beginning balances don't print on my report?

If they don't print, go back to Chapter 2  and record them with the
account name.

What if my reports won't print correctly?

Review your Windows documentation and make sure you've selected the
correct printer. In your 'Program Preference' screen you marked 1 for
Laser printer or 2 for Dot Matrix printer.

My printer won't work?

There could be several reasons. Check these:

1) Is the printer power cable plugged into an electrical outlet?
2) Is your printer power switch in the ON position. Check to make sure
your printer is ON-LINE.
3) Is the printer cable connected to the printer and the computer? If
the cable is loose, the printer won't print.
4) If you printer worked earlier, but won't print now, the printer
buffer could be full or have some wrong codes entered. Turn the
printer OFF. Wait three seconds and then turn it back ON. Try printing
the report again.
5) Make sure the correct printer driver is installed.

How do I change my Password?

See Chapter 6 (Utilities) of the EPES Reference manual to learn how to
change your password. When you received the program, the password was
'PASSWORD'.

What if an account balance isn't correct?

Select the "Current Balances" option under the Utilities Menu to
correct it. If it's still wrong, check your check, receipt, and
transfer entries.

What if my computer prints an error message?

The program is attempting to tell you what problem it encountered. For
example, it may tell you your printer isn't ready. To correct it, turn
on your printer.

If an error does occur and you have an option to 'Log the error and
continue', select this option. The error can be viewed under 'Error
Log Table' of the Administrators Menu.
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If I use the 1099 Export File option to write my 1099 information to a
diskette, what does the file on the diskette contain?
The file is an ASCII delimited file, separated by commas, and contains
the following information:

1) Vendor Name
2) Vendor Address
3) Vendor City
4) Vendor State
5) Vendor Zipcode
6) Vendor Tax ID number
7) Total amount of money paid to the vendor.

Can I have multiple Checking Accounts?

Yes. By default, account 992 is the checking account. You may add
additional (General Ledger) checking accounts. Be sure you mark the
Checking Account box [X] for each checking account. (Highlight the

Checking Account box and press [Tab] or click on it with the mouse.)

When your ask to print checks, reconcile your bank statement or print
various reports, the program will ask you which checking account to
use.

Why select the General Ledger Account "Cash on Hand" when entering
Receipts?
Two Reasons:
1) When you receive money each day, technically, it is cash on hand

until you deposit it in the bank.
2) At the end of the day, select the 'Record Bank Deposit' option

under Transfer & Deposits of the File Menu. This will ask you how
much money there is to transfer to your checking account from Cash
On Hand.

When the money is transferred, one deposit entry is recorded in
Receipts. This makes reconciling your bank statement at the end of the
month much easier. Instead of having many deposit entries for each
day, you'll have only one entry.

When would you select a General Ledger account other than "Cash on
Hand", when entering receipts?

When you are recording interest received on an account or an
outstanding deposit balance (when beginning the program), you'd select
the general ledger account to post the interest to.

What did I do wrong if my bank statement doesn't reconcile to zero?
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Check the following:
1) Did you enter a wrong cancellation date on a check?

2) Has any entry been updated from a prior month, after the bank
statement was reconciled?

3) Did you record a transaction manually and forget to put it in the
computer?

4) Did you accidentally put in a duplicate transaction?

5) Did you void a check or receipt manually and forget to put it in
the computer?

6) Did you enter an outstanding check or deposit and forget to select
the Current Balance option under the Utilities Menu?

Adjusting Entry
If you've checked everything and you're still out of balance, you'll
have to enter an adjusting entry before you can reconcile your bank
statement.

If the balance for your statement is  positive, you'll have to
manually enter an adjusting check entry.

For example, if you had a statement balance of $1.53, you'd enter a
check for $1.53. (Add a vendor named Adjusting Entry.) You'll have to
decide which account number to use in making this adjusting entry.

If the balance for your statement is  negative, you'll have to enter
an adjusting receipt entry.

For example, if you had a statement balance of $-1.21, you'd enter a
receipt for $1.21. (Add a vendor named Adjusting Entry.) You'll have
to decide which account number to use in making this adjusting entry.

How do I Void a Check?

To void a check that has been written in the current month:

Select 'Checks Paid' under the File Menu.

Use the Find option. Search on Check # to get the check on the screen
to void.

Edit each line item entry on the screen and enter 0 (zero) as the
amount of the check.  Under the Memo field, type VOID (and enter the
amount of the check). The total amount of the check should be zero
when done. Record a cancellation date on the check entry.
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Reversing Entry
If voiding a check from a previous year or month, add a duplicate of
the original entry except the amount will be negative and the date
will be the date of the Bank Statement being balanced.  Cancel both
the original and the new reversal entry using the Bank Statement date.

How do I handle NSF (Bad) Checks?

An NSF check is a check returned by the bank for non-sufficient funds.

There are two ways to handle these checks without altering any
previous reports.

Suppose the original receipt entry was:

Activity Account:000102
General Ledger Account:000992 (Checking)
Received From: John Doe
Receipt #: 1234
Amount: 15.00

Method 1
When the check is returned, record a reversing entry. It will be
identical to the original entry, except the amount will be for
negative -15.00 and the date will be the Bank Statement date.
When the check is re-deposited or cashed, record another receipt for
the original amount.

Method 2
This method provides a way to keep track of the total of all NSF
checks.

First, select 'Accounts' under the File Menu. Then select 'General
Ledger Accounts'.

Add another General Ledger Account.
For example:
General Ledger Account #: 996
Account Name: NSF CHECKS
Beginning Balance: 0

Select 'Transfers & Deposits' under the File Menu. Select 'General
Ledger Transfer'.

Add an entry:

Date:
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Press [Tab] to select today's date or enter the correct date.

From Acct:
Enter your checking account number. In our example, it's 992.

To Acct:
Enter your NSF General Ledger Account. In our example, it's 996.

Amount:
In our example, it's 15.00.

Document:
(Optional) Enter a reference number for this transfer.

Note:
Enter a brief description. For example: John Doe, NSF Check

When the Check is cashed or re-deposited, enter the following
information:

Select 'Transfers & Deposits' under the File Menu. Select 'General
Ledger Transfer'.

Add an entry:

Date:
Press [Tab] to select today's date or enter the correct date.
From Acct:
Enter your NSF account number. In our example, it's 996.
To Acct:
Enter your checking account number . In our example, it's 992.
Amount:
In our example, it's 15.00.
Document:
(Optional) Enter a reference number for this transfer.

Note:
Enter a brief description. For example: John Doe

To write off a bad check:
Select 'Receipts' under the File Menu.

When prompted "Select an Account", select 996. Our example assumes you
have set up a GL Account 996 for NSF Checks.

Click ‘Add’ to Add a new entry.

Receipt #:
Enter the receipt number. In our example, it's 1234.
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Date:
Enter the correct date for this receipt.
Vendorcode (Received From):
Enter who the check was received from. In our example, it's John Doe.

On the detail line, enter:
Account:
Enter the Account Number. In our example, it's 102.
Sub Acct:
Enter the Sub-Account number. In our example, its 0.  (Press [Tab].)
Note:
Enter a brief description. For example:
John Doe, NSF written off.
Amount:
Enter the reversing amount. In our example, it's -15.00.

My receipt won't print?

Check your Program Preferences. You probably have not told the program
to print receipts.

To do this, select 'Program Preferences' under the Utilities Menu.

In the bottom left of the screen, you should see [X] Print Receipts.
If the box is not marked [X] click on it with the mouse or use the Tab
key to highlight it and press [Tab].

If the box is marked, check your printer and printer cables to make
sure the printer is ON-LINE and properly connected.

Note: You can also use the <Print Receipt> Button on the screen.

My Checks or Receipts aren't printing correctly?

Check your Program Preferences. You may have selected the incorrect
printer.

To do this:
Select 'Program Preferences' under the Utilities Menu.

Under 'Format' check which printer is selected. Enter a 1 for a laser
printer or 2 for a dot matrix printer.

Check to make sure you have the proper printer driver installed.

I just can’t get everything to balance:
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These procedures have been written to provide suggestions to assist
you in locating “out of balance” problems with the data entered in the
EPES SOFTWARE.  We receive several copies of School data daily.  Most
balancing problems are – voided entries, incorrect dates, amounts and
cancel dates.  We have found that by following these steps, most out
of balance conditions can be located and corrected:

1. Check Fiscal Year dates (UTILITIES SECTION – Program Preferences)
and
 Bank Reconciliation dates.  Be sure they are correct.

2. Run “Current Balances to Disk” under the UTILITIES SECTION.
3. Ending Balance from Bank Statement must be correctly entered.
4.   Outstanding Deposit – Deposit made, not reflecting on Bank

Statement.
5. Run “List of Outstanding Checks” (thru date must be same as ending

Bank Statement).  If this amount is not the same as the Bank
Reconciliation:
A. Search for the dollar amount difference between cash balances

on lines 4 and 8.
a. Check date, amount, vendor code and name, cancel date and

account number
b. Check for duplicate entries.
c. Check Journal Adjustments.

6. Run a “Sequential List of checks and receipts” and compare with
Bank Reconciliation checks
and receipts.

7. Run a “General Ledger” for the month (using same dates as Bank
Statement).  Your total
receipts and transfers to checking account must be same amount
unless your school carries an ending balance in the Cash on Hand
account.

8. Go to “Checks Paid” and look for zero amounts.  You cannot zero
out a check from a previous month or year.  You must use reversal
entries to void a previous period check.

9. Go to “Receipts” and look for zero amounts.  Same rule applies as
checks.

10. Go to “Transfer and Deposits”, look for a date prior to fiscal
year date.

11. Go to “GL Transfer”, your deposits for that month should match the
bank statement amount.

12. Run a “Sequential list of Checks – By Check #”
On the query box click on “Cancelled” then click on “is equal to”
and in the compare box put in the date you cancelled the checks,
(example 10/31/2001).  The total amount of these checks should
equal the amount of checks that has cleared the bank for that
month with the exception of any NSF or Bank Fees that appears on
the Bank Statement.

If you are unable to find your “out of balance” problem with the above
procedures, you may mail a copy of your backup data to our support
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staff to assist.  There will be a $37.50 per hour charge for finding
balancing problems.  If we discover that the software created the
problem there will be no charge.  If you mail your data you must
provide enough information to assist us in locating the problem.



Chapter 8
Introduction to Purchase Order Module

1

INTRODUCTION

Purchase Order Program Module

This program module is used to enter, print, and keep track of all
purchase orders issued by the school. You can receipt an entire
purchase order or line item by clicking one button with your mouse. In
addition, you can enter partial receipts for a purchase order line
item and make changes as needed. Once all items are received, you can
automatically post the purchase order to accounts payable, if your
using the basic accounting module .

You'll print a wide variety of reports to the screen or printer.

You'll use the mouse or keyboard to operate the program. Pull down
Menus and Windows make the program extremely easy and quick to use.
You don't have to be a CPA to operate the program. Double entry
accounting is done automatically for you.

Help is just a keystroke away! Press [F1] or click on Help with the
mouse at any time... from anywhere in the program.

Security is built into the program to protect your data from unwanted
users.
It's simply to use, yet very effective.

I. Purchase Order Program.

This manual explains the specific details about the Purchase Order
program. Think of it like a receipe. It contains all the details or
what you want to do.

The Purchase Order manual contains:

Chapter Information                   
  1 Quick Start, Installing the

program and Overview.

  2 File Menu, Information to Add to
the program.

  3 Output Menu, Purchase Order
Reports you can print to the
screen or printer.
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  4 Utilities Menu, Special programs
to simplify your accounting work.

II. EPES Software Reference Manual

This manual explains how to:
• Select Menu Options.
• Use the keyboard or mouse.

• Make Backups of your data.
• Add, Edit, and Delete information... and much more.

The EPES Reference manual contains:

Chapter Information                   
  1 File Menu, How to select program

options, Close Files, select
Printers, and Exit the program.

  2 Edit Menu, How to Edit entries.

  3 Commands Menu, How to use the
Tool Bar Menu to add, edit, and
view information; how to use
keyboard or mouse to move around
in the program.

  4 Output Menu, How to print reports
to the screen or printer.

  5 Window Menu, How to move a window
on the screen, change it's size,
and select other windows on the
screen.

  6 Utilities Menu, Programs which
perform special functions like
backing up your data, recreating
damaged indexes, etc.

  7 Help Menu, How to get help using
the program.

  8 Administrator Menu, How to add
users to the program and assign
their rights to add, edit, delete
or view information.
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Think of the reference manual as an oven. You can use the oven every
time you bake. Once you're familiar with how the oven works, you know
how to use it for all your recipes.

We have one major objective in mind:

Once you know how to use one EPES program for Windows, you'll know how
to use all of them.

How is the Manual Written?

The following information will help you understand how the manual is
written.

Symbol    Meaning                       
[ ] Information enclosed in brackets means to press a key. For

example, [A] means press the letter A.

<   > Information enclosed in braces means to select a command on
the screen. For example, < Add > means select the Add
command.

'   ' Information enclosed in single quotes means to select a Menu
option. For example, 'Accounts' means select the Accounts
option from the Menu.

"   " Information enclosed in double quotes refers to a message on
the screen or a section in your manual.

_______: Information followed by a colon refers to information you
are to type into the program. For example, Password: means
type in the password.
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QUICK START

This chapter is an overview of the Purchase Order program. You'll
learn how to install/Register the program and get started.

Installing the EPES Purchase Order Program
If you have already installed the Accounting Program you can proceed
directly to the “First Time you Run the Program” option below.  The
Purchase Order Module is included with the Accounting Software

Place the School Accounting CD in your CD Rom drive, select Run. Enter
the following:

E:Setup (or whatever drive is assigned to your CD Rom Drive)

To install the program, follow the instructions displayed on the
screen. When the program has been successfully installed, the final
message you'll see will be "Installation is complete". Put the
original program CD in a safe storage place.

Installing Additional EPES Accounting Programs

The EPES Accounting program includes the Purchase Order and the
Extended Code programs.  You can preview either of these programs in
“Demo” mode at any time by going to the “Switch Program” option and
selecting the program you want to preview.  If you decide to purchase
either of these modules you will only receive a “Registration”
diskette which will change these programs from a “Demo” to a fully
functional program.  Chapter 5 of this manual provides detailed
instructions.
Each module purchased will be a ‘Demo’ until registered.

First Time You Run the Program
After first installing the program, the program is running in ‘DEMO’
mode.  In Demo mode you can test every option in the program.

Registering the Program:
To gain unrestricted access to the program you must register it.  To
register a program, do the following:
1) Purchased from our Sales Office:
If you ordered the program from our office the registration
information is on the CD Rom.  Put the CD Rom in your CD Rom Drive.

Under the Utilities Section select
‘Registration/Support’, select
‘Register Program’.
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If you are registering from an older version on Diskette, the defaults
are set to register the Accounting Program, you will need to check the
box marked “Purchase Order” then select {OK}.  To register from the CD
Rom you will need to check the box marked “Other Drive Path” and enter
your CD Rom drive path in the box.
Once the appropriate options are entered select ‘OK’.
2) Registering a Demo program downloaded from our Web Site.
If you downloaded the demo program and want to purchase it contact our
sales office :1-800-424-7512 or email us at:
sales@epessoftware.com.  When payment or Purchase Order is received
you will be sent a registration file for the program.  Put that file
on a floppy diskette and follow the same instructions in step 1 above.

Log In Screen

Enter the following information:

ID: BK (press enter)

Password: PASSWORD <Enter>

This is the ID and Password for the Bookkeeper. There is also another
login ID included which is assigned to the System Administrator.  If
you do not have a System Administrator you can contact our Support
Group to obtain this login ID which will give you unlimited access to
any of the file security programs.

You can change the password, under the 'Change Password' option of the
Utilities Menu.

Daily Start Up

To start the program, select the Purchase Order icon within the EPES
Software Group of your Windows Program Manager.

Enter your ID: BK  and
Password: PASSWORD

(The Password can be changed at any time under the “Utilities
Section”.)
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File Menu

This chapter explains how to set up your Purchase Order Program and
begin adding information under the File Menu.

Setting Up the Purchase Order Program

STEP 1 - Get to the Master Menu
Select the Purchase Orders icon from your Windows Program Manager to
start the program.

Enter the following information:

ID: BK 
(or the ID that has been set up for you.)

Password: PASSWORD
(or the password you have set up for you.)

The Master Menu will appear at the top of the screen:

STEP 2 - Enter your Program Preferences
Select 'Purchase Order Preferences' under the Utilities Menu. Complete
your desired options then select [OK].

STEP 3 - Assign Accounts
If you have not already set up your Activity, G.L. and Sub Accounts
from the Accounting program see Step 3, pg 2.1

ADDING INFORMATION:

Use the following steps to add information using the File Menu of your
program:

ADDING VENDORS
If you have not already setup your Vendors using the Accounting
Program see STEP 8 – ADDING VENDORS (pg 2.6)

Adding Ship To
Use this option to record the information on where your purchase
orders are to be shipped.

Select 'Purchase Order' under the File Menu.

Select 'Ship To' under 'Purchase Order'.
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Select < Add >.

Shiptocode:
Enter a unique ship to code to describe this school. For example: CES

Shipname:
Enter the school's name. For example: Central Elementary.

Shipattn:
Enter the name of the person to ship this purchase order to. For
example: John Q. Principal.

Shipadd:
Enter school's address. For example: 121 E. North

Shippobox:
Enter a P.O. box if applicable. For example: P.O. Box 433

Shipcity:
Enter the school's city. For example: Magnolia

Shipstate:
Enter the school's two digit state abbreviation. For example: AR

Shipzip:
Enter the school's zipcode. For example: CENT

Telephone:
Enter the school's telephone number, area code first. For example:
501-234-1234

Use the Tool Bar Menu at the top of the screen.

Save and keep adding, Save, Cancel (Tool Bar Menu) (Tool Bar
Menu)
Select < Save and keep adding > to save this ship to record and add
another one.

Select < Save > to save this ship to record.

Select < Cancel > to undo what you've added and exit.

Adding Purchase Orders
Use this option to record your purchase orders.

Select 'Purchase Order' under the File Menu.

Select 'Purchase Orders Add/Edit' under 'Purchase Order'.
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Select < Add >.

PO Number:
Press [Enter] to accept the current P.O. Number or type in the new
P.O. number.

Date Ordered:
Press [Enter] to accept today's date ore type in the correct date for
this purchase order.

Vendorcode:
Enter the vendor code or press [F5] to select from a popup list.

Shipto:
Enter the ship to code or press [F5] to select from a popup list.

Add new line item:
Press [Enter] to add a P.O. detail line to this Purchase Order.

Account:
Enter the Activity Account or press [F5] to select from a popup list
of accounts. For example: 100  (for General Fund)

Sub-Acct:
Press [Enter] for no sub-account or enter the Sub-Account code. Press
[F5] to select from a popup list of sub-accounts.

Expense Codes:

Note: These fields will be skipped unless you're using the Extended
Code program module and have marked them for use. See the Extended
Code Preference option in Chapter 4.

Enter any expense code(s). If you don't know the expense codes, press
[F5] to select from a popup list.

Qty Order:
Enter the quantity ordered for this line item.

Unit Desc:
Enter the unit description. For example: each, boxes, or dozen.

Unit Price:
Enter the unit price for this line item.

Description:
Enter a brief description for this line item.

Tax Amount:
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Press [Enter] unless this item involves a taxable item. Then, enter
the amount of sales tax for this item.

Note: The tax amount is included in the amount for this line item.

[ ] Mark for 1099:
Click with the mouse to mark this disbursement for 1099 reporting.

Save line item and exit, Add another line item, Cancel line item
(P.O. Detail)

Select < Save line item & exit > to save this line item and return to
master PO Screen.

Select < Add another line item > to save your line item and add
another.

Select < Cancel line item > to undo what you've added and exit.

Note: If you've added more than one line item, you'll be asked whether
to cancel the last item entered or all line items.

When you return to the purchase order screen, use the Tool Bar Menu at
the top of the screen.

Save & keep adding, Save, Close or Cancel from the main tool bar.

Select < Save & keep adding > to save this Purchase Order and add
another

Select < Save > to save this Purchase Order.

Select < Close > to exit the PO Screen.

Select < Cancel > to cancel this Purchase Order and exit.

< Print Purchase Order >
Select this option to print your purchase order to your printer.

Receive Purchase Orders
Use this option when your receive your purchase orders.

Select 'Purchase Order' under the File Menu.

Select 'Purchase Orders Received' under 'Purchase Order'.

< Receive entire Purchase Order >
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Use this option to receive the entire purchase order or the remaining
items on this purchase order.

Press [R] or Click on < Receive entire Purchase Order >

Date P.O. Received:
Press [Enter] to accept today's date or type in the correct date these
purchase order items were received.

< Receive Partial P.O.or change PO line item >
Use this option to:
1) receive an entire line of a Purchase Order,

2) receive a partial line of a Purchase Order

3) make changes in what you received,

Press [P] or Click on < Receive Partial P.O.or change PO line item >
Use the Tool Bar options to get the line item of the purchase order on
the screen that you want to receive.

< Receive Line Item >
Use this option to receive an entire line of a purchase order.

Press [L] or

Click on < Receive Line Item >
Date P.O. Received:
Press [Enter] to accept today's date or type in the correct date this
purchase order line item was received.

Qty Rec:
Enter the quantity received for this line item.

Date Rec:
Enter the date this line item quantity was received.

Select < Save > to record your receipt information.

Select < Save & Exit > to add another received quantity and received
date for this line item.

Select < Cancel > to quit without saving your information.

< Change Line item > Not available under this option.

Qty Rec:
Update the quantity received for this line item.
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Date Rec:
Update the date this line item quantity was received.

Select < Save > to record your changes to this receipt item.

Select < Cancel > to quit without saving your information.

< Erase > Not available under this option

OUTPUT
(Reports)

This chapter explains the Standard Reports to print to the screen or
printer.

Note: This Menu is Not highlighted if you are viewing information on
the screen. Quit what you're doing and return to the Master Menu.

The standard reports are:

• Vendor Listing
• Chart of Accounts
• P.O. Reports
• Other reports listed refer to Activity Accounting only

Select Output from the Master Menu, and a window similar to the
following will appear:

Vendor Listing

This report prints a list of vendors.

Select 'Vendor Listing' under the Output Menu. A Report Query box will
appear:

Select < PreView > to view the report on your screen.

Select < Print > to print this report to your printer.

See the EPES Reference manual, Chapter 4, to learn how to limit the
information printed and save your work for later use.
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Chart of Accounts

This report prints a list of Activity Accounts, General Ledger
Accounts, or Sub-Accounts.

Select 'Chart of Accounts' under the Output Menu.

Select your report listing: Accounts, GL Accounts, Sub-Accounts,
Accounts Only, or GL Accounts only.  The Accounts only reports do not
display balances.

Select PreView to print to the screen.

Select Print to print to your printer.

See the EPES Reference manual, Chapter 4, to learn how to limit the
information printed and save your work for later use.

P.O. Reports

Use this option to select which purchase order report to print.

Select 'P.O. Reports' under the Output Menu.

Select your report:

Open Purchase Orders
This report prints a list of all purchase orders / partial purchase
orders not yet received.

Purchase Orders Received
This report prints a list of all purchase orders / partial purchase
orders received.

Ship To Information
This prints a list of schools where purchase orders are shipped to.

Purchase Order Budget Report
This prints a budget report for your purchase orders. It shows the
Total Purchase order amounts, Total amount still opened, the budgeted
amount, and percentage used.

PO Deficit Balance Report
This report prints a listing of all Accounts with a deficit balance
created by the PO Entries.

Financial with Encumbered
This reports prints all Accounts with the current encumbered amounts.
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Open PO By Account
Provides a listing of all Open PO’s by Account.

Open PO By Sub Account
Provides a listing of all open PO’s by Sub Account.

All reports use the Report Query format. See the EPES Reference
manual, Chapter 4, to learn how to limit the information printed and
save your work for later use.

Select PreView to print the report to the screen.

Select Print to print the report to your printer.

Select Done to return to the Master Menu.
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Utilities Menu

This chapter explains the Utilities Menu programs that are unique to
the Purchase Order Program. All other Utility Menu programs are
explained in detail in the Accounting Manual and Chapter 6 of the EPES
Reference Manual.

Select the “Utilities” Menu

Purchase Order Preferences
Use this screen to enter some basic purchase order information.

Select 'Purchase Order Preferences' under the Utilities Menu.

[üü ] Print PO Number on Purchase Orders:
Check this box if you want the program to print purchase order
numbers. Unmark the box if your purchase orders are pre-numbered.

Purchase Order Terms:
You have five line items for purchase order terms. This information
will printed at the top of each purchase order as it appears on the
screen.

Current PO Update
Use this option when you have a computer problem or power failure. It
recomputes all Purchase Order quantities received and open amounts.
Then, it reconstructs your data files.

Post PO's to Accounts Payable
If you're using the basic accounting program module, use this option
to post purchase orders received to accounts payable.

Note: This option will not post partial purchase orders received to
accounts payable.
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Chapter 5

Switch Option

This chapter explains the Switch Menu. Use this menu to:

1) Switch between program modules of the School Accounting program.

Select the Switch Option

Switch Program Module

When you have more than one program module installed, use this option
to quickly and easily switch from one Accounting program module to
another.

Select 'Switch Program Module' under the Switch Option.

Select the program module to switch to and then select < OK >.

Note: This option will also allow you to switch to programs not yet
purchased to preview those modules in “Demo” mode only.




